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Read First 
 
 Informatik is a graphics viewer for multi-page Tiff and other image formats.  The program features 
an extensive selection of reformatting and markup functions. Informatik Viewer also includes a 
basic Optical Character Recognition (OCR) function. Informatik Viewer supports Microsoft’s XPS 
files. XPS files allow you, via the Microsoft XPS Document Writer (printer), to convert any printable 
documents to Tiff files.  

Informatik Viewer requires the Microsoft Framework 4.0 or later. Frameworks are freely available 
from the Microsoft website. 

A ‘read-only’ version of Informatik Viewer is also available. The version has all options of the full 
version, but the Reformat and Markup functions are disabled. See section below for more 
information. 

Informatik Viewer supports the standard screen resolutions, but may not fully support custom 
resolutions. 

Check frequently for software upgrades.  Click on Help menu button for the link.  

When you make changes to a file, always make sure that you have valid backup, and always check 
the output. Please read the full text of the License and Warranties section in this document, and do 
not use the program unless you agree with the terms. Report any error conditions to Informatik 
technical support. Comments and suggestions are always appreciated. 

Demo Version, Licensing 
 
For educational, personal, non-business use, Informatik Viewer is free, as a fully functional trial 
version. For business use, a license must be purchased after 30 days, or the trial must be un-
installed. For large corporate licenses, the one-time fee can be below one dollar per user.  For more 
licensing information, visit www.informatik.com or www.informatik.us, or contact Informatik Inc  for a 
quote. 

If you purchase a license you will receive an unlock code.  The unlock code is entered in the Help / 
Registration menu.  Once entered and the program re-started, the program will run in licensed mode 
without nag messages. 

Associate file extensions 

If you wish to associate the .tif file extensions to Informatik Viewer, RIGHT-click on any Tiff file, 
then choose ‘Open with’ from the dropdown menu. Select the InformatikViewer executable from 
the C:\Program Files (x86)\Informatik Inc folder (or the folder that you specified at 
installation. Check the checkbox ‘Always use the selected….’. The exact procedure depends on the 
Windows version.   
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Supported formats 
 
Opening files:  Single and multi-page Tiff (most common compressions), BMP, GIF, PNG, JPEG. 

Saving files: Single or multi-page Tiff, BMP, GIF, PNG, JPEG.  By default, monochrome Tiffs are saved 
in the CCITT4 format; color Tiffs are saved in LZW format. When saving a multipage file to Tiff 
format, you can opt to save all, save a single page or page ranges.  The ranges can be in ascending 
or descending order. This option allows you to re-arrange pages of a multi-page Tiff file, and to 
remove pages.  Saving to JPEG format, prompts you to enter a quality factor; the default is 80. The 
default can be changed in Setup. 

For reason of caution, the only Save menu option is ‘Save As’. If you edit an image, it is 
recommended that you save it under a different name so that it does not accidentally overwrite the 
original file, in case you want to reverse the edit. Edited output should always be checked for 
correctness. 

Although Informatik Viewer does not have direct PDF conversion functions, to and from, simple 
conversion methods are available within Windows and Informatik Viewer. Please review sections 
below. 

Viewing the image files 
 
The image display can be set to  

 Fit-to-size  
 Fit-to-width  
 Full display 

 
Click on the icon in the left sidebar and Iterate through the display modes. The default mode can be 
specified in Setup.  You also have an option to view large images with either the scrollbar or with 
panning. The panning option is accessible by icons in the upper-right corner of the screen, or in 
Setup. Informatik Viewer also has a useful magnifier option. With the CTRL key pressed select the 
area that you wish to see magnified.  

For multi-page files, you may want to activate the thumbnails. Click on the icon in the upper-left 
corner, or select it in Setup. 

Informatik Viewer includes a scrollbar lock. The lock is useful if you view a series of pages and want 
the scroll bar to remain in a set position. The option is accessed in the upper-right corner of the 
screen, or in Setup. 

For zoom and rotation, click the icon in the left sidebar. Many short-cut keys are available. For a list 
of shortcuts, click the option in the Help menu. 
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Image Information 

Select ‘Image Information’ from the ‘Other’ menu for technical data on the current image:  Width, 
height, horizontal and vertical resolution, graphics format and compression, color depth, number of 
pages.  The information refers to the original image, before any image reformatting or markups. 

OCR –Optical Character Recognition 

Informatik Viewer includes the basic OCR option. The initial installation includes the language files 
for English. Separate language files are available (free) for French, German, Italian, Spanish, 
Portuguese and Dutch. Please download zip files from download pages in www.Informatik.com or 
www.informatik.us.  

Once you have downloaded the language file, unzip it and place the individual files in the OCR sub-
folder that you see when you click on a language selection. 

The OCR option works as follows:  Press the OCR menu button and select the language. Your 
language is defaulted.   On the displayed image, outline the area that you wish to read. After a few 
seconds the text will be saved in a temporary text (.txt) file and is displayed in the default text 
viewer. Copy-paste the text and apply as needed. 

Screen capture 

To capture the screen, select the Screenshot option from the ‘Copy’ menu.  Optionally, set the time 
delay so that you can prepare the screen for capture, for example, you may want to include an open 
dropdown list. Note, the screen behind the Informatik Viewer window is captured. The capture is 
stored in the Windows Clipboard, open it from the Copy menu. If you want to capture a single 
screen window, see instructions in the Screenshot menu – ‘Other methods’. 

Setup 

Please explore the Setup window. Setup allows you to specify many default settings. The Setup 
window can also be used to change some settings for the current session. The Setup window always 
reflect the current state of the settings. Only by clicking the ‘Save as default settings’ are the 
selections saved as defaults and applied when you open the program. 

Linked applications 

In Setup you can specify up to five (5) applications that can be launched by the Informatik Viewer 
program by passing the file name as an argument. The ‘Linked Applications’ option (in the File 
menu) is enabled only if you have set up at least one linked application. Informatik Viewer passes 
the current file name as an argument to the linked application. Not all applications support 
standard commands. 
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Pages 
 
You may want to re-arrange pages of a multi-page Tiff file, or remove some pages. This can easily be 
done with the Save function. Open the multi-page file that you wish to re-arrange and select the 
Save option from the File menu. Specify the new page lineup with page numbers and ranges of 
pages, for example: 1-3, 5-7, 10, 13, 20-14. The link in the Save dialog window shows more 
examples. 

Multi-page 
Split a file, combine pages 
 
The ‘Other’ menu includes two functions: 

 Split a multi-page Tiff file into separate page files. 
 

 Combine single-page files into a multipage Tiff file. Note, all the files to be combined must 
first be placed in a separate folder. All files must be single-page files. 

Convert Any-to-Any  
Convert any file to Tiff (XPS printer driver) 

You can convert any printable document to a graphics file. Use this simple ‘printer driver’ method.  

1. Open the file in the file's native application, for example Microsoft Word. Open PDF files in any 
PDF viewer. 

 
2. Select the Print option and choose 'Microsoft XPS Document Writer' as the printer. Click Print 

button. 
 

3. In the 'File name' field, type the output file name. The file name MUST have the .xps extension 
(not .oxps). Click 'Save' button. 

 
4. Wait while the system completes the conversion.  If nothing happen, you may need to release a 

flickering icon in the bottom task bar. 
 

5. When the 'print' process is completed, open the .xps file in the Informatik Viewer (not in other 
image viewers).  In the dropdown list next to the Filename text box, select 'XPS as Tiff' 
(monochrome of color). Click 'Open' button. 

 
6. The file now opens as a Tiff. The conversion is complete.  Optionally, re-open the XPS file and 

save the file in another image format. 
 
Note: For PDF output, select the ‘Microsoft Print to PDF’ instead of  'Microsoft XPS Document Writer'. 
 



7 
 

Convert PDF files 
 
Informatik Viewer does not directly support PDF files. However there are easy work-around 
functions to convert graphics files to PDF and vice versa (not available on very old Windows 
operating systems). 

Convert graphics files to PDF: 

1. Open the graphics file. 
 

2. In the Print menu, select the ‘Microsoft Print to PDF’. Press OK. 
 

3. Specify the output PDF file name. 
 

4. Click on Save button. 

 

Convert PDF to graphics: 

Use the procedure outlined above in the Convert Any-to-Any section. Start with opening the PDF 
file in any PDF viewer. 

Reformatting and Markup 

Informatik Viewer offers an extensive choice of reformat and markup options. The functions are split 
into two types:   

 Reformat  
 Markup. 

 
Reformatting  options change the image format or the appearance of an image. Examples:  resolutions, 
rotation, deskew, rotation, border cleanup, transparency, color, etc.  Each time you make a change, a 
backup file is created, and you can later restore the image.  

Markups options add dynamically created graphics objects to the image, for example:  drawing, 
redactions, highlighting, etc.  Each markup is a movable graphics object.  The markups can be dragged, 
edited, cancelled. You can create many markups on a page. The markups must be confirmed (realized 
and rendered) before you move to another page or file, or before you make reformat changes . Once so 
confirmed, you can no longer edit the individual markups. However, rendering the markups creates a 
backup and you can restore the page. Also, you can re-create last batch of markups on a fresh page. 
Before closing a file, you must save the changes, or they are discarded. 

Reformat options 
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 Rotation 
Right-angle rotation, specific angle rotation. flip 
 

 Resolution (PPI) 
Change resolution with or without resampling. Resampling changes the resolution but retains 
the dimensions of the image, adding or removing pixels. 
 

 Resize 
Change the dimensions of the image, retainig the width-height ratio 
 

 Deskew 
Automatic skew detection or manual deskewing by drawing a skew line 
 

 Despeckle 
Despeckling removes some stray pixels. 
 

 Border cleanup 
Outline a rectangle; the area outside the rectangle is whited out. This option is useful if you wish 
to remove black borders created by the scanner. 
 

 Crop 
 

 Invert 
Inversion of colors. Black becomes white, etc. 
 

 Convert to monochrome 
Convert a color image to single-bit in order to reduce the file size. Colors are dithered. Light 
colors may become invisible, while dark colors may be rendered black.  
 

 Colorize 
For example,  change a photograph to antique sepia color 
 

 Color flooding 
Flood a contiguous area with a selected color 
 

 Brighten, darken, contrast, blank 
 

 Transparency 
Renders an image partially transparent.  When using this option, the file must be saved in Tiff, 
PNG or BMP format. Transparency is not supported in JPEG or GIF format.  A selected color 
(usually white) can be set to be  100% transparent. 
 

 Color sampling  
With the mouse, select a pixel, and the color will be reflected in the Color dialog. The color 
dialog can show the technical data of the color, such as RGB data. 
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Markups options 

You can add as many markup objects to a page. To move or edit a markup, click on it. A red rectangle 
appears around the markup indicating that it is active and ready for dragging and editing. An Edit 
window opens next to the markup, showing the various edit options.  The markups are temporary until 
confirmed. Once confirmed, they can no longer be edited, but you can restore the page to an earlier 
state via Undo options. For multi-page files, you are prompted to confirm the markups when you move 
to another page.   

 
 Text annotations 

Options for font and color. Text can be rotated at any angle. Click at spot of text, or draw line at 
an angle. 
 

 Redaction, whiteout (erase) 
There are two methods of redactions and white-out: Rectangle and Line method. If you need to 
redact a skewed line or a curved line, use the Line method. A drawn redaction line can be 
skewed and bent.  
 

 Yellow marker, highlighting 
 The standard method is by drawing a rectangle. This method brings out the best quality, 
especially if the page’s backcolor is white. If you need to highlight skewed or curved line, use the 
‘Line method’ of the Redaction, after checking the Transparency and optionally changing the 
color.  When editing, you can tilt and widen the line, or curb the line.  
 
If your original image is monochrome and you wish to keep the output in monochrome (so as to 
minimize the file size), use the Highlight function as follows: a) Use the standard ‘Rectangle’ 
method, but use pure black as the color, or b) use the  ‘Line’ method of Redaction, black color, 
with the Transparency checked. (not available on some old operating systems, test it first). 
 

 Shapes and patterns  
Lines (with optional arrow anchors) 
Rectangles  
Ellipses  
Arrows  
Freehand drawing  
Irregular shapes, paths  
Text balloons  
Numbered bullets 
 
Options:  Color, line width, dash lines, fill,  hatch patterns, opacity, rotation, transparency.  
Closed drawings can be filled with color and hatch patterns (opaque or transparent). 
Corner points of irregular shapes can be moved with the drag handle. 
 

 Image inserts 
Images from files or clipboard 
Options: Rotate, resize, opacity, transparency, make white fully transparent 
Image inserts an be resized with the drag handle, or by clicking plus/minus buttons. 
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 Replicate sectione 
Copy a section of the image and move it. The vacated space can be whited out with the 
Redaction option. 
 

 Watermarks 
Two options: solid letters or outline letters. 
 

 Stamps  
 

 Code 39 barcodes 
 

 Curved and round text 
Resize, rotage, color, tighten, widen 
 

 Irregular shapes 
Edges of irregular drawings can be dragged.  Click on edge and find hotspot. Hotspots are small; 
you may need to click more than once.  
 
 

Color 
When selecting a color, the Color dialog is displayed.  Select a standard color or click on ‘Define Custom 
Colors’. If you use the Color Pick option, the sampled color is retained in the Color dialog. 
 
Line width 
You can set the line width for individual drawings. The default width can be set in Setup. Once a line is 
drawin you can still change it via the edit option. 
 
Resize 
Some markup objects can be resized by dragging a size handle (lower right corner of the object). Other 
objects, for example rectangles, are resized by clicking on plus/minus buttons. 
 
Rotation 
Some markup objects can be rotated at an exact angle, others rotate only at right angle. Activate the 
markup, and in the Edit window, click on the Rotation button.  Select the angle with the ‘clock dial’, or 
click on one of the right-angle buttons, or increase/decrease the angle in steps by clicking on the plus or 
minus buttons. Use CTRL for left/right and top/bottom alternatives.  Line objects can be rotated by 
moving the handlehandle at either end of the line. 
 
Fill options 
Clicking on the ‘Fill options’ iterates through various looks and hatch patterns, depending on the type of 
object. For pattern fills, the frames can be removed: minus-click on ‘Line width’ button till frame 
disappears. Irregular shapes can be filled only if the gap is closed. 
 
Dash styles 
The option iterates through several styles. 
  
Add arrow heads 
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The option iterates through three looks: arrow at end of line, arrow at beginning of line, arrow on both 
ends. 
 
To top 
The option moves the markup object to the top, above any other markups. This option is useful if a 
markup is covered behind another markup and needs to be edited. 

Read-only version 
 
 A ‘read-only’ version of Informatik Viewer is also available. The version has all options of the full 
version except that Reformat and Markup are disabled. Ask for a ‘55’ license code, or for demo 
version, use this code (entered in the Help menu):   XXXX1XXXX1XXXX1XXXX55XXX 

Technical Support 

The technical support contact information is shown in www.informatik.com and www.informatik.us 
web pages.  

Before you contact Support, please review any FAQ links in the Help menu. 

Copyright and Trademark Notices 
 

Copyright 20012-2017 Informatik Inc.  All Rights Reserved.  Supplied AS IS without any liability, 
direct or indirect.  Backup all files before you use them in this program.  You must also read and 
agree to the License terms, shown below. 

 TESSERACT Copyright and License Notice: 

Copyright Protected and Licensed under the Apache License, Version 2.0 (the "License"); you may 
not use this file except in compliance with the License. You may obtain a copy of the License at 
http://www.apache.org/licenses/LICENSE-2.0. Unless required by applicable law or agreed to in 
writing, software distributed under the License is distributed on an "AS IS" BASIS, WITHOUT 
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for the 
specific language governing permissions and limitations under the License. 

License, Warranty, Disclaimer 
 
Please read the terms carefully before installing and using the software, as such conduct will 
indicate your acceptance of all of the terms of this license agreement.  If you do not agree with the 
terms, the software cannot be licensed to you and you must un-install and destroy the software 
files. 
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This License Agreement is a legal agreement between Informatik Inc. ("Licensor"), a Pennsylvania 
Corporation, and you, the user ("Licensee"), and is effective the date Licensee installs the software. 

This Agreement covers all materials associated with the Informatik Viewer software, including, 
without limitation, the downloadable software product, online documentation, and any additional 
supporting electronic files (herein, the "Software"). 

The evaluation version may be used for 30 days after installation.  Unless otherwise agreed, it is 
unlawful to use the software after the 30 day evaluation period without licensing the software and 
paying the license fees.  If a license is not obtained before the expiration of the 30 day evaluation 
period, the Software must be un-installed and destroyed.  Please visit the www.informatik.com or 
www.informatik.us web pages for pricing information. 

1. GRANT OF LICENSE 

Licensor hereby grants to you, and you accept, a nonexclusive license to use the Software according 
to the following condition: 

For each User Unit, you may use the Software on one (1) personal computer or workstation, owned, 
leased, or otherwise controlled by you and used by you for personal or business purposes, and as 
authorized in this License Agreement. A single license represents one (1) User Unit.  A multi-user 
pack represents the specified number of User Units.  The Software may not be transferred to other 
computers over a network. The software may be installed on one (1) laptop or equivalent. The 
Software may not be installed on a web server without a special license.  

A site license covers an unlimited number of software installations, on PCs, workstations, servers, for 
use by the licensed company, at one site, including laptops or equivalent used by employees attached to 
that site.  Web applications are excluded. Technical support is to be handled via one central person or 
department. 

An enterprise license covers an unlimited number of software installations, on PCs, workstations, 
servers, for use by the licensed company, world-wide, including parent, subsidiaries and affiliates. Web 
applications are excluded. Technical support is to be handled via one central person or department. 

2. LICENSOR'S RIGHTS 

Licensee acknowledges and agrees that the Software is proprietary to Licensor and protected under 
international copyright law. Licensee further acknowledges and agrees that all right, title, and 
interests in and to the Software, including associated intellectual property rights, are and shall 
remain with Licensor. The License Agreement does not convey to Licensee an interest in or to the 
Software, but only a limited right of use that may be revoked in accordance with the terms of this 
License Agreement. 

3. OTHER RESTRICTIONS 

Licensee agrees to make no more than one (1) backup copy of the Software. Licensee agrees not to 
assign, sublicense, transfer, pledge, lease, rent, or share the rights assigned under this License 
Agreement. Licensee agrees not to reverse assemble, reverse compile, or otherwise translate the 
Software. 
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4. TERM 

This License Agreement is effective when Licensee installs the Software and shall terminate only if 
the terms of this License Agreement are broken. Licensee agrees to destroy the Software upon 
termination of this License Agreement. 

5. NO WARRANTY; LIMITATION OF LIABILITY 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL LICENSOR BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

6. GOVERNING LAW 

This License Agreement shall be construed and governed in accordance with the laws of 
Pennsylvania. 

7. SEVERABILITY 

Should any court of competent jurisdiction declare any term of this License Agreement void or 
unenforceable, such declaration will have no effect on the remaining terms hereof. 

8. NO WAIVER 

The failure of either party to enforce any rights granted hereunder or to take action against the 
other party in the event of any breach hereunder shall not be deemed a waiver by that party as to 
subsequent enforcement of rights or subsequent actions in the event of future breaches. 

 
 
 


